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MS Word Tables and Forms 
Tables 

Why Use Tables? 
! Use Tables instead of Columns 

You may think of lists with items lined up across from each other as columns. 
Columns in Word work like newspaper columns. In these, information flows 
down one column and into the next column, so that the items are not lined up.  
The information in column 1 is not related to the information in Column 2.  

Tables, on the other hand, align so that the information in one column does 
relate to the information in another one.  

! Use Tables instead of Tabs 
If you’re thinking about using tabs to organize a page, tables will probably do 
it better. For instance, on a resume, you have headings on the left and detailed 
information on the right. Check out the resume templates to see how this 
works. (Go to File, New, Other Documents, and Professional Resume.dot.) 
If in doubt, go to Table####Show Gridlines so you’ll see it’s a table. 

Creating Tables 
Word can create very nicely formatted tables. You might wonder why you wouldn’t use 
Excel for this. Word creates excellent tables if there are no calculations. In addition, 
Word makes it easier to work with tables where the columns are not perfectly lined up: 

    

    

   

    

  

Word tables would probably be what you want when you have a need for a table within a 
Word document. 

Creating Tables 

Fast and Easy 
1. Click Table, then Insert Table. You’ll get this: 
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2. If you click OK, you’ll get a table that fills the width of the margins, with 2 
columns and 2 rows. The rows will be the height of the formatting of the style 
you’re in at the time, probably normal, and the columns will be exactly half of 
the space. 

3. To put anything into the cells, click on the first cell and type something, then 
press Tab to go to the next cell. You’ll go to the right, then down to the next 
row, then to the right in that row, etc. When you’ve run out of rows and continue 
to press Tab, you’ll automatically get another row. 

4. Notice the little starburst-like characters in the cells… if you turn the paragraph 
mark button on (and you should!). These are end of cell markers, and they show 
up after any text you have typed into the cell. They appear on the screen but don’t 
print. Word stuffs paragraph and cell formatting information into the markers. 

5. At the end of each row are end of row markers which also contain formatting 
information. And at the end of the entire table, you’ll see an end of table marker. 

6. If you hold the cursor over the last vertical line in the table it will turn into a 
double-headed arrow. Now you can click and drag the line to the left or right, and 
at the same time a ruler will pop up. 

7. To remove a row, click to the left of the first cell in the row you want to delete. 
Click Table, Delete Rows. 

Draw a Table 
Another way to create a new tale is to draw it. 

1. Click Table, Draw Table. You’ll get the Tables and Border toolbar, and your 
cursor becomes a little pen, and the Office Assistant leaps in to help.  
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2. Click to get rid of the Office Assistant, and draw the outer boundaries of your 
new table with your pen cursor. 

3. You can draw vertical line, which will turn into table lines as soon as you release 
the mouse button, and cells appear. You can also craw horizontal lines, which 
may or may not go all the way to the edge of the table. 

4. Click the eraser icon and then click a line you don’t want, and it will be erased. 

5. This drawing tool will also work with a table created with the Table, Insert 
Table dialog box. 

AutoFormat a Table 
1. Click Table#Insert Table#AutoFormat. 

2. Take a look at the formats Word gives you and choose one. Click OK. 

3. You can also use AutoFormat on a table that’s finished. 

Selecting Cells, Rows or Columns 
! To select a column, move the mouse pointer over the top of the column, and 

click when the shape of the pointer changes to a black arrow pointing downward. 

! To select a row, move the mouse pointer to the left edge of the row. Click when 
the pointer changes to a white arrow pointing up and to the right. 

! To select a cell, move the mouse pointer inside the left boundary of the cell. 
Click when the pointer changes to a white arrow pointing up and to the right. 
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! To select multiple cells but not an entire row, align the mouse pointer correctly to 
select the first cell but don’t click. Drag across the cell and into the next cell. 

Merging and Splitting Cells 
Click on any cell. Click the Split Cells button on the 
Tables and Borders toolbar, if it’s still up. Or, click 
on the cells you want and click Tables, Split Cells. 
You’ll get a Split Cells dialog box: 

You can use the eraser to remove lines and merge 
cells that way. You can set up a header by merging all 
the cells in the top row into one cell. 

Insert and Delete Cells, Columns and Rows 
! To insert a row, put the insertion point in the row you want to appear below the 

new row. Click the Insert Row button or choose Table, Insert Row. The new 
row will contain the formatting of the first row you selected. 

! You can insert several rows by selecting the number of rows you want to insert 
before you click the Insert Row button. Delete several cells by selecting them 
before you click Table####Delete Cells. 

! To delete cells, select the cells and go to Table, Delete Cells. You’ll be asked 
how you want to adjust the table. 

! To delete a row or column, select it and go to Table, Delete Row or Table, 
Delete column. 

Changing Row and Column Dimensions 
! You can change the size of a row or column by dragging its border or drag the 

column or row marker in the ruler. If you drag a right column border or marker to 
the right, you’ll make that column wider. 

! If you hold down the Shift key while dragging a column border, you’ll adjust the 
width of the selected column and you’ll change the size of the whole table. If you 
hold down the Ctl key while dragging, you’ll redistribute the width of the 
selected column to all columns to the right. 

! You can set row and column dimensions exactly by clicking Table, Cell Height 
and Width to get the dialog box below. 

! You can also use the commands Distribute Rows Evenly and Distribute 
Columns Evenly. They’re on the Tables menu and the Tables and Borders 
toolbar. 



Margie Metzler F:\engineering\webresources\tablesforms.doc 
(408) 822-3185; margie@netapp.com 

 

http://web.netapp.com/engineering/webresources/manuals.html  
 5 03/09/01 

! To adjust a column to accommodate 
the longest line, use AutoFit. Place 
the insertion point anywhere in the 
column you want to adjust, choose 
Table, Cell Height and Width, and 
display the Column tab. Click 
AutoFit. 

Navigating in a Table 
! While you’re typing, Word wraps text 

within the cell an d adjusts the cool’s 
height. If you press Enter, you put in 
a paragraph mark which adds another 
row. 

! You can move the insertion point by clicking in any cell. 

! To go to the next cell, press Tab. 

! To go one cell back, press Shift+Tab. If either cell has text in it, the text will be 
automatically selected. 

! If you press Tab when the insertion point is in the lower-right column you’ll add 
a new row at the bottom. 

! Pressing the Left or right arrow key moves the insertion point character by 
character through a cell. When you’re at the last character the arrow key moves 
the insertion point into the next cell. 

! Press Alt+Home to move the insertion point to the beginning of a row. 

! Press Alt+End to move the insertion point to the end of a row. 

! Press Alt+Page Up to move the insertion point to the top of a column. 

! Press Alt+Page Down to move the insertion point to the e bottom of a table.. 

Selecting Text in a Table 
! If you want to select the text in a cell, turn on the paragraph mark and chose the 

text only, not the end of cell marker. If you want to select the actual cell and its 
contents, include it. 

! To apply formatting to a cell, you have to select the cell marker. 

Applying Formatting to Table Cells 
! To apply borders and shading to selected cells, select the cells and click the tool 

in the Table and Borders toolbar, or go to Format#Borders and Shading. 
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! You can change text direction (make sideways text) by using the text direction 
tool in the Tables and Borders toolbar or choosing Format####Text Direction. 

! You can select the entire table and click on Table####Table Autoformat to 
format the entire table. 

! To align the contents of cells, select the cells and use the alignment button on the 
Tables and Borders toolbar. 

! To align the table on the page, select the entire table and use the Indent buttons 
on the Formatting toolbar. 

! To select the entire table, place the insertion point anywhere in the table. Choose 
Table, Select Table.  Remember that changing page margins won’t affect 
placement of your table on the page. 

! To change alignment of the contents of one cell, place the insertion point 
anywhere and choose the alignment button you want. 

Inserting Tabs in Table 
! Press Ctl+Tab. 

Cutting or Copying Table Information 
! When you cut or copy cell information, you move character formatting, but not 

cell formatting. 

Splitting Tables 
! To add room at the top of a page for text, click in the first row of the table and 

click Table, Split Table. Word adds a paragraph mark above the table and 
places the insertion point in that paragraph. 

! To split one table into two tables, click in the row that should become the first 
row of the second table and click Table####Split Table. 

Table Page Breaks 
! If you insert a page break in a table (Ctl+Enter), Word will break the table into 

two tables. 

! To create recurring headers, select the heading rows and click 
Table####Headings. 

! Table headings appear only after automatic page breaks. If you manually insert a 
page break, no table heading will appear. 

! If you don’t want Word to split a row across two pages, place the insertion point 
anywhere in the table and click Table, Cell Height and Width. On the Row tab, 
remove the check from Allow Row to Break Across Pages. 
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! When you change the setting in the Cell Height and Width dialog box, you 
change it for every row in the table. 

Converting Text to Tables 
1. Make sure the text contains paragraph markers or tabs, to distinguish where new 

columns should begin. 

2. Select the text to be converted. 

3. Choose Tables, Convert Text to Table. You’ll get this dialog box: 

4. In the Separate Test At box, choose Paragraph, Tabs, Commas, or Other. If 
you choose Other, type the character you want to use to separate text into 
columns. 

5. Change the number of columns you want in your table. Word calculates the 
number of columns and rows based on the separator you choose. 

6. Choose OK. 

Converting Tables to Text 
1. Select the table to convert. 

2. Choose Tables, Convert Table to Text. You’ll see the Convert Table to 
Text dialog box. 

3. In the Separate At box, choose Paragraph, Tabs, Commas, or Other. 

4. Click OK. 

Using Calculations 
! If you put the insertion point in a cell under a column of numbers, Word 

assumes you want to sum the column. Click Table, Formula, and you’ll see 
the formula dialog box. Click OK. 

! To create other formulas, do as above and display the Formula dialog box.  

! Clear the formula. 
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! Type an equal sign (=). 

! Use the Paste function list box to choose a formula. 

! Here are the available functions: 

ABS(x) Displays the absolute value of a number of a formula, regardless of 
its actual positive or negative value.  

AND(X,Y) Used in logical expressions, AND returns the value 1 if both x and 
y are true, or 0 if either is false. 

AVERAGE() Calculates the average of a list of numbers separated by commas in 
the parentheses. 

COUNT() Displays the number of items in a list, which appears in the 
parentheses, separated by commas. 

DEFINED(x) Displays 1 if the expression is valid, or 0 if x cannot be computed. 

FALSE Displays 0 

IF(x,y,z) Evaluates x and displays y if x is true, or z if false. X is a 
conditional expression and y and z can be either a numeric value or 
the words “True” and “False”. 

IN(x) Displays the numbers to the left of the decimal place in a value or 
formula. 

MIN() Displays the smallest number in the list in the parentheses. 

MAX() Displays the largest number in a list. 

MOD(x,y) Displays the remainder that results from dividing x by y a whole 
number of times. 

NOT() Returns the value 0, meaning false, if x is true, or 1, meaning true, 
if x is false. X is a logical expression. 

OR(x,y) Returns 1 for true if either or both x and y are true, or the value 0, 
meaning false, if both x and y are false. 

PRODUCT() Displays the result of multiplying a list of values. The list of values 
appears in parentheses. 

ROUND() Displays the value of x rounded to y number of decimal places. X 
can be either a number of the result of a formula. 

SIGN() Displays the value 1 if x is a positive number, or the value –1 if x is 
a negative number. 
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SUM() Returns the sum of a list of numbers or formulas that appear, in the 
parentheses. 

TRUE() Displays 1. 

Sorting 
1. Place the insertion point anywhere in the table. You’ll get the Sort dialog box. 

2. Use the Sort By list boxes to select the primary column to sort by. 

3. Use the other two Then by list boxes to identify tie-breakers if Word finds 
duplicate entries in the primary sort column. 

4. Click OK. Word re-sorts the table information. 

5. Note: you can sort by paragraphs as well. 

Taming Unruly Tables 
When you first add a table to your document, Word determines column width by dividing 
the space available between margins by the number of columns in the table. If you later 
add a column to the table, the inserted column will push the right edge of the table past 
the right margin. This may make it difficult to “grab” and resize the right-most column. 

There are several ways to deal with this type of situation. Some WordTips readers 
suggested changing to landscape orientation, adjusting column width, and then switching 
back to portrait orientation. Another thing to try, however, is to switch to Normal view, as 
opposed to Page Layout view. This allows you to see the columns that extend past the 
right margin and make any adjustments. 

If you want to adjust all the columns so everything fits as well as possible, follow these 
steps: 

1. Select the entire table. 
2. Choose Cell Height and Width from the Table menu. This displays the Cell 

Height and Width dialog box. 
3. Make sure the Column tab is selected. 
4. Click on AutoFit. 

 
The effect on your table depends on whether your table contains information, or not. If 
the table is empty, the columns are evenly resized so they fit within the page margins. If 
there is information in any of the columns, the column width is set so that information fits 
on a line (if possible). Once your column widths are set in this way, you can do any final 
column adjustment, as necessary. 

Putting Tables Within Margins 
In the last tip you learned about one way you can make sure a too-wide table fits within 
the margins of your page. Here’s another way: 



Margie Metzler F:\engineering\webresources\tablesforms.doc 
(408) 822-3185; margie@netapp.com 

 

http://web.netapp.com/engineering/webresources/manuals.html  
 10 03/09/01 

1. Select the entire table. 
2. Choose Cell Height and Width from the Table menu. This displays the Cell 

Height and Width dialog box. 
3. Make sure the Column tab is selected. 
4. Adjust the Width of Column setting so it says Auto. (A quick way to do this is to 

type any letter in the setting, then click on the down arrow on the spinner.) 
5. Click on the OK button. 

 
It may not be immediately obvious what the difference is between this approach and the 
approach of clicking on AutoFit, as described in the previous tip. The difference is that 
this method always sets the column widths evenly within margins, whereas the previous 
tip may result in uneven column widths between margins. Obviously, the method you use 
is up to you and what you want to have happen with your tables. 

Distributing Columns Evenly 
When it is time to format a table, you may find that your overall table width is set the way 
you want it, but the columns within the table are not “just right.” For instance, you may 
want the columns to be the same width as each other without disturbing the overall width 
of the table. 

One way to handle this situation if you are using Word 97 is to select the table and then 
choose Distribute Columns Evenly from the Table menu. Word dutifully adjusts 
individual column widths without affecting the overall width of your table. 

Spacing Table Rows Vertically 
When you are working with tables, you may wonder how you can easily add space before 
a table row. This can be important when you have the table formatted with borders, and 
the text in the table is too close to the border at the top of the row. Word makes it easy to 
add space after the information in a row, simply by adjusting the height of the row itself 
so it is greater than the space occupied by the information in the row. But what about 
before a row? 

The easiest way to solve this problem is with paragraph formatting. If you have a single 
paragraph in each cell of a row, simply select the row. You can then follow these steps: 

1. Choose Paragraph from the Format menu. This displays the Paragraph dialog box. 
2. Adjust the Before setting so it represents the amount of space you want between 

the text and the row border. (A good setting is either 3 or 6 pt.) 
3. Click on OK. 

 
You can also use this method if you have multiple paragraphs in each cell. The 
difference, however, is that you should select the top paragraph in each cell and format 
just it, instead of formatting the paragraphs in the row as a whole. 
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Drawing a Table 
As an alternative to using the convenient Insert Table command (or toolbar tool), you can 
use the draw-a-table feature of Word 97 by following these steps: 

1. Click your mouse on the Tables and Borders icon on the toolbar. 
Word displays the Tables and Borders toolbar and switches you to Page Layout 
view (if you are not using Page Layout view already). The Draw Table tool on the 
toolbar is automatically selected, and your mouse pointer looks like a pencil. 

2. Use the mouse pointer to define the outside borders of your table, much as you 
would draw in a drawing program. 

3. Use the Draw Table tool to draw the columns and rows into the table. 
4. Close the Tables and Borders toolbar. 

If the Tables and Borders toolbar is not visible on your screen, you can also display it by 
choosing the Draw Table option from the Table menu. 

Forms 

Using the Forms Toolbar 
Go to View####Toolbars and click Forms. You’ll get the Forms Toolbar: 

The Forms Process 
1. Create a table in Word if you’d like items in your form to line up nicely. 

2. Type text and using the Forms toolbar, choose the type of input field you want: 

• Radio button  (People can choose only one item) 

• Text box (they type in text) 

• Check box (Yes/no, or selecting more than one item) 

• Drop-down box, or combo box: Users get a list of items to choose from. 
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2. Right-click each field and choose Preferences. This allows you to define how 
people can use the fields you’ve set up. 

3. Lock the form. This keeps people from typing anywhere but in the fields you’ve 
defined. 

4. Save the form. 

Quick Forms: Creating a Questionnaire  
How would you like to use Word to create an online questionnaire?  Suppose your 
organization needs to know the approximate income of each of its active members. 

Open a new Word document and type in all the header information. With the sales 
pitch in place, let’s get to the questions. Type something like this:  

$10,001 - $20,000  
$20,001 - $40,000  
$40,001 - $60,000  
$60,001 - $80,000  
$80,001 - $100,000  

Over $100,000  

Now click the document to the right of $20,000 (maybe add a space and then click). 
Choose Insert, Form Field. When the dialog box opens, select Check Box and 
click OK. The check box will appear in your document to the right of $20,000. Do 
the same now for all the numbers.  

To use the questionnaire online, choose Tools, Protect Document. When the 
Protect Document dialog box opens, select Forms and click OK. Now the only 
thing anyone can do is select one of the check boxes—they can’t modify the 
document.  

After someone finishes the questionnaire, you need to save the document. Choose 
File, Save As and type in a name. Click Save to save the document. You can open 
the documents that you collect and print them later.  

If you want to mail some of the questionnaires, the check box will show up just 
fine, so the members can make the selection with a pen and mail it back to you. This 
is one style of questionnaire to fit all purposes. 

Printing Data Only for Forms 
If you’d like to print only the data from a Word form, you can instruct Word to do this 
for you. Choose Tools, Options. When the Options dialog box opens, click the Print 
tab. Select the check box labeled Print Data Only for Forms and click OK.  

The selection remains in effect only for the current document. When you open a new 
document, the selection will return to the default. 



Margie Metzler F:\engineering\webresources\tablesforms.doc 
(408) 822-3185; margie@netapp.com 

 

http://web.netapp.com/engineering/webresources/manuals.html  
 13 03/09/01 

Index 
Auto, 10 
AutoFit, 5, 10 
AutoFormat, 3 
Borders, 4, 5, 6, 11, 12 
calculations, 1 
Calculations, 8 
Cell Height and Width, 5, 7, 10 
Check box, 12 
column, 1, 4, 5, 6, 8, 9, 10, 11 
Columns, 1, 4, 5, 11 
combo box, 12 
Converting Tables to Text, 8 
Converting Text to Tables, 7 
Data, i, 13 
Delete Rows, 2 
Distributing, 11 
Draw a Table, i, 2 
Draw Table, 3, 11, 12 
Drawing, 11 
Drop-down box, 12 
end of cell markers, 2 
end of row markers, 2 
eraser, 3, 4 
Form Field, 13 
formatting, 2, 4, 6, 7, 11 
Formatting, i, 6 
Forms, 13 
Forms Toolbar, i, 12 
Formula, 8 
function, 8 
Insert, i, 2, 3, 4, 11, 13 
Lock, 13 
margin, 10 

margins, 10 
Margins, i, 10 
marker, 2, 5, 6 
Merging, 4 
Navigating, 5 
Office Assistant, 3 
Options, 13 
orientation, 10 
paragraph mark, 2, 5, 6, 7 
Preferences, 12 
Printing Data Only, 13 
Protect Document, 13 
questionnaire, 13 
Radio button, 12 
remove, 2, 4, 7 
Rows, i, 4, 5, 11 
ruler, 2, 5 
Selecting, 4 
Show Gridlines, 1 
Sorting, 9 
Spacing, 11 
Splitting, 4, 7 
Tab, 2, 5, 7 
Table Page Breaks, 7 
Tables and Border toolbar, 3 
Tables and Borders toolbar, 4, 5, 6, 11, 

12 
Tabs, 1, 7, 8 
Text box, 12 
Text Direction, 6 
Vertically, 11 
width, 2, 5, 10, 11 
Width of Column, 10 

 
 


	Tables
	Why Use Tables?
	Creating Tables
	Creating Tables
	Fast and Easy
	Draw a Table
	AutoFormat a Table

	Selecting Cells, Rows or Columns
	Merging and Splitting Cells
	Insert and Delete Cells, Columns and Rows
	Changing Row and Column Dimensions
	Navigating in a Table
	Selecting Text in a Table
	Applying Formatting to Table Cells
	Inserting Tabs in Table
	Cutting or Copying Table Information
	Splitting Tables
	Table Page Breaks
	Converting Text to Tables
	Converting Tables to Text
	Using Calculations
	Sorting
	Taming Unruly Tables
	Putting Tables Within Margins
	Distributing Columns Evenly
	Spacing Table Rows Vertically
	Drawing a Table

	Forms
	Using the Forms Toolbar
	The Forms Process
	Quick Forms: Creating a Questionnaire
	Printing Data Only for Forms


